
 

ΗΥ-SPSS 
Statistical Package for Social Sciences  

 
Paired Samples t- test 

One-way repeated measures ANOVA 



Κριτήριο t για εξαρτημένα δείγματα (Paired Samples t- test) 

 
• Παραμετρικό test 
Πότε χρησιμοποιείται; 
• Όταν έχουμε ΜΙΑ ΕΞΑΡΤΗΜΕΝΗ – ποσοτική μεταβλητή 
π.χ. Μέγιστη Πρόσληψη Οξυγόνου 

• Που έχει ΜΟΝΟ ΔΥΟ βαθμίδες - μετρήσεις 

Π.χ. Αρχική – Τελική μέτρηση & 
Θέλουμε να βρούμε αν υπάρχουν ΔΙΑΦΟΡΕΣ στην ΕΞΑΡΤΗΜΕΝΗ 
μεταβλητή (π.χ. Μέγιστη Πρόσληψη Οξυγόνου) μεταξύ αρχικής (pre) 
και τελικής μέτρησης (post) 
ΠΡΟΣΟΧΗ: Τα ίδια άτομα που συμμετέχουν στην αρχική μέτρηση, 
τα ίδια άτομα συμμετέχουν και στην τελική μέτρηση 



Κριτήριο t για εξαρτημένα δείγματα (Paired Samples t- test) 

Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχουν στατιστικά σημαντικές διαφορές στη Μέγιστη Πρόσληψη 

Οξυγόνου (VO2max) μεταξύ αρχικής (pre) και τελικής μέτρησης (post) 
Εναλλακτική Υπόθεση (Η1) 
• Θα υπάρχουν στατιστικά σημαντικές διαφορές στη Μέγιστη Πρόσληψη 

Οξυγόνου (VO2max) μεταξύ αρχικής (pre) και τελικής μέτρησης (post) 

Μηδενική Υπόθεση (Η0) 
• Δεν υπάρχουν στατιστικά σημαντικές διαφορές στη βαθμολογία των 

Μαθηματικών μεταξύ τoυ Α΄ εξαμήνου και του Β’ εξαμήνου 
Εναλλακτική Υπόθεση (Η2) 
• Θα υπάρχουν στατιστικά σημαντικές διαφορές στη βαθμολογία των 

Μαθηματικών μεταξύ του Α΄ εξαμήνου και του Β’ εξαμήνου 
 

Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχουν στατιστικά σημαντικές διαφορές στη Ποιότητα Ζωής πριν και 

μετά την εφαρμογή ενός προγράμματος άσκησης 
Εναλλακτική Υπόθεση (Η3) 
• Θα υπάρχουν στατιστικά σημαντικές διαφορές στη Ποιότητα Ζωής πριν και 

μετά την εφαρμογή ενός προγράμματος άσκησης 



Κλικ στο OK 

Κριτήριο t για εξαρτημένα δείγματα (Paired Samples t- test) 

Analyze → Compare Means → Paired Samples T-test… → Παίρνω 
ταυτόχρονα τις δύο βαθμίδες (VO2max_pre, VO2max_post) της 
εξαρτημένης μεταβλητής (VO2max) από αριστερά και τις τοποθετώ 
δεξιά στο κουτί Paired Variables & πατάω OK 

 



Κριτήριο t για εξαρτημένα δείγματα (Paired Samples t- test) 

 
Paired Samples Statistics 

 

  
 

N 

 Std. Error 

Mean   Mean Std. Dev iation 

Pair 

1 

VO2max_pre 

VO2max_post 

47,1655 

53,2115 

20 

20 

4,09526 

4,13684 

,91573 

,92502 

 
Paired Samples Correlations 

 

 N Correlation Sig. 

Pair VO2max_pre & 

1 VO2max_post 
20 ,362 ,117 

 
 

 
Paired Samples Test 

 

 Paired Diff erences    

 
 

 
Mean 

 
 

 
Std. Dev iat ion 

 

 

Std. Error 

Mean 

95% Confidence 

Interv al of the 

Dif f erence 
 

t df Sig. (2-tailed) Lower Upper 

Pair VO2max_pre - 

1 VO2max_post 
-6,04600 4,65021 1,03982 -8,22236 -3,86964 

 
-5,814 19 ,000 



Κριτήριο t για εξαρτημένα δείγματα (Paired Samples t- test) 

 
Εάν υπήρχουν στατιστικά σημαντικές διαφορές γράφουμε: 
Εφαρμόστηκε κριτήριο t για εξαρτημένα δείγματα (Paired 
Samples t- test) για να εξεταστεί εάν υπάρχουν υπάρχουν 
στατιστικά σημαντικές διαφορές στη Μέγιστη Πρόσληψη 
Οξυγόνου (VO2max) μεταξύ αρχικής (pre) και τελικής μέτρησης 
(post). Από τα αποτελέσματα φαίνεται ότι υπάρχουν στατιστικά 
σημαντικές διαφορές στη Μέγιστη Πρόσληψη Οξυγόνου 
(VO2max) μεταξύ αρχικής και τελικής μέτρησης (t19 = -5.814, p < 
.001). Οι συμμετέχοντες είχαν υψηλότερο σκορ στη τελική 
μέτρηση (Μ = 53.21 ± 4.14) της Μέγιστης Πρόσληψης Οξυγόνου 
σε σχέση με την αρχική μέτρηση (Μ = 47.17 ± 4.10). 



Κριτήριο t για εξαρτημένα δείγματα (Paired Samples t- test) 
 

Εάν ΔΕΝ υπήρχαν στατιστικά σημαντικές διαφορές θα γράφαμε: 
Εφαρμόστηκε κριτήριο t για εξαρτημένα δείγματα (Paired Samples 
t- test) για να εξεταστεί εάν υπάρχουν υπάρχουν στατιστικά 
σημαντικές διαφορές στη Μέγιστη Πρόσληψη Οξυγόνου (VO2max) 
μεταξύ αρχικής (pre) και τελικής μέτρησης (post). Από τα 
αποτελέσματα φαίνεται ότι ΔΕΝ υπάρχουν στατιστικά σημαντικές 
διαφορές στη Μέγιστη Πρόσληψη Οξυγόνου (VO2max) μεταξύ 
αρχικής και τελικής μέτρησης (t19 = -1.686, p = .108). 

 

 
Paired Samples Test 

 

 Paired Diff erences    
 
 

 
Mean 

 
 

 
Std. Dev iation 

 

 

Std. Error 

Mean 

95% Confidence 

Interv al of the 

Dif f erence 

 t df Sig. (2-tailed) Lower Upper 

Pair VO2max_pre - 

1 VO2max_post 
-,11750 ,31173 ,06971 -,26340 ,02840  -1,686 19 ,108 



Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

 
• Παραμετρικό test 
Πότε χρησιμοποιείται; 
• Όταν έχουμε ΜΙΑ ΕΞΑΡΤΗΜΕΝΗ – ποσοτική μεταβλητή 
π.χ. Μέγιστη Πρόσληψη Οξυγόνου 

• Που έχει ΠΑΝΩ από ΔΥΟ βαθμίδες - μετρήσεις 

Π.χ. 1η Μέτρηση - 2η Μέτρηση - 3η Μέτρηση & 
Θέλουμε να βρούμε αν υπάρχουν ΔΙΑΦΟΡΕΣ στην ΕΞΑΡΤΗΜΕΝΗ 
μεταβλητή (π.χ. Μέγιστη Πρόσληψη Οξυγόνου) μεταξύ πρώτης, 
δεύτερης και τρίτης μέτρησης 
ΠΡΟΣΟΧΗ: Τα ίδια άτομα που συμμετέχουν στη πρώτη μέτρηση, τα 
ίδια άτομα συμμετέχουν στη δεύτερη και στη τρίτη μέτρηση 



Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχουν στατιστικά σημαντικές διαφορές στη Μέγιστη Πρόσληψη 

Οξυγόνου (VO2max) μεταξύ μεταξύ πρώτης, δεύτερης και τρίτης μέτρησης 
Εναλλακτική Υπόθεση (Η1) 
• Θα υπάρχουν στατιστικά σημαντικές διαφορές στη Μέγιστη Πρόσληψη 

Οξυγόνου (VO2max) μεταξύ μεταξύ πρώτης, δεύτερης και τρίτης μέτρησης 

Μηδενική Υπόθεση (Η0) 
• Δεν υπάρχουν στατιστικά σημαντικές διαφορές στη βαθμολογία των 

Μαθηματικών μεταξύ τoυ Α΄ εξαμήνου, του Β΄ εξαμήνου και του Γ’ εξαμήνου 

Εναλλακτική Υπόθεση (Η2) 
• Θα υπάρχουν στατιστικά σημαντικές διαφορές στη βαθμολογία των 

Μαθηματικών μεταξύ τoυ Α΄ εξαμήνου, του Β΄ εξαμήνου και του Γ’ εξαμήνου 

Μηδενική Υπόθεση (Η0) 
• Δεν θα υπάρχουν στατιστικά σημαντικές διαφορές στο ΔΜΣ πριν, κατά τη 

διάρκεια και μετά την εφαρμογή ενός προγράμματος άσκησης 
Εναλλακτική Υπόθεση (Η3) 
• Θα υπάρχουν στατιστικά σημαντικές διαφορές στο ΔΜΣ πριν, κατά τη διάρκεια 

και μετά την εφαρμογή ενός προγράμματος άσκησης 



Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

• Analyze → General Linear Model → Repeated Measures… → Στο 
Within-Subject Factor Name δίνω όνομα στη μεταβλητή (π.χ. 
VO2max) → Στο Number of Levels βάζω τον αριθμό των βαθμίδων 
– μετρήσεων της μεταβλητής (π.χ. 3) → Κλικ στο Add και μετά στο 
Define → Παίρνω ταυτόχρονα τις τρεις βαθμίδες - μετρήσεις 
(VO2max_Τ1, VO2max_Τ2, VO2max_Τ3) της εξαρτημένης 
μεταβλητής (VO2max) από αριστερά και τις τοποθετώ δεξιά στο 
κουτί Within-Subject Variables (VO2max) → Κλικ στο Options → 

Παίρνω την εξαρτημένη μεταβλητή (VO2max) από αριστερά και τις 
τοποθετώ δεξιά στο κουτί Display Means for → Κλικ στο Compare 
main effects → Επιλέγω LSD & Descriptive statistics → πατάω 
Continue → Κλικ στο Plots → Παίρνω την εξαρτημένη μεταβλητή 
(VO2max) αριστερά και την τοποθετώ δεξιά στο κουτί Horizontal 
Axis → Κλικ στο Add → Continue & OK 



Κλικ στο Add 

Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

 

 



Κλικ στο Add & 
μετά στο Define 

Κλικ στο Options 

Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

 
 

 



Κλικ στο Continue Κλικ στο Plots 

Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

 

 



Κλικ στο Add & Continue Κλικ στο OK 

Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

 
 

 



Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

 
Descriptive Statistics 

 

 Mean Std. Dev iation  N 

VO2max_T1 54,9267 3,15879  6 

VO2max_T2 55,1650 2,60504 6 

VO2max_T3 55,7707 2,81490 6 

 
 
 
 
 
 

 
 

 
Measure: MEASURE_1 

Mauchly's Test of Sphericityb
 

 
 

 
Within Subjects Eff ect 

 
 

 
Mauchly 's W 

 

 

Approx. 

Chi-Square 

 
 

 
df 

 

Epsilon
a

 

 Greenhous 

e-Geisser 
 

Huynh-Feldt 
 

Lower-bound Sig. 

VO2max ,505 2,733 2 ,255 ,669 ,823 ,500 

Tests the null hypothesis that the error covariance matrix of the orthonormalized transf ormed dependent variables is 

proportional to an identity matrix. 

a. May be used to adjust the degrees of f reedom f or the averaged tests of significance. Corrected tests are display ed in 

the Tests of Within-Subjects Eff ects table. 

b. 

Design: Intercept 

Within Subjects Design: VO2max 

• Στο Mauchly΄s Test of Sphericity 
θέλουμε το Sig να ΜΗΝ είναι 
στατιστικά σημαντικό (p> .05) 

• Sphericity: Ομοιογένεια της 
συνδιακύμανσης - Oι συσχετίσεις 
μεταξύ των συνδυασμών των 
προσπαθειών είναι ίσες 



Ty pe III Sum 

• Στο Mauchly΄s Test of Sphericity θέλουμε το Sig να μην είναι στατιστικά σημαντικό (p> 
.05). Εάν είναι στατιστικά σημαντικό (p < .05) τότε χρησιμοποιούμε τις τιμές που 
παρουσιάζονται στη γραμμή του τεστ Greenhouse-Geisser ή στη γραμμή του τεστ 
Huynh-Feldt, που θα προσαρμόσει τους βαθμούς ελευθερίας, θα ανεβάσει την τιμή 

του F και θα περιορίσει τον κίνδυνο του σφάλματος τύπου I 

Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

 

 

 

 
Tests of Within-Subjects Effects 

Measure: MEASURE_1 

 

Source of Squares   df Mean Square F Sig. 

VO2max Sphericity Assumed  2,272   2 1,136 3,295 ,080 

Greenhouse-Geisser  2,272   1,338 1,698 3,295 ,110 

Huy nh-Feldt  2,272   1,646 1,381 3,295 ,094 

Lower-bound  2,272   1,000 2,272 3,295 ,129 

Error(VO2max) Sphericity Assumed  3,447   10 ,345   

Greenhouse-Geisser  3,447   6,689 ,515   

Huy nh-Feldt  3,447   8,228 ,419   

Lower-bound  3,447   5,000 ,689   



Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

 
Εφαρμόστηκε Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο 
Παράγοντα (One-way repeated measures ANOVA) για να εξεταστεί 
εάν υπάρχουν στατιστικά σημαντικές διαφορές στη Μέγιστη 
Πρόσληψη Οξυγόνου (VO2max) μεταξύ πρώτης (VO2max_Τ1), 
δεύτερης (VO2max_Τ2) και τρίτης μέτρησης (VO2max_Τ3). Από τα 
αποτελέσματα φαίνεται ότι ΔΕΝ υπάρχουν στατιστικά σημαντικές 
διαφορές στη Μέγιστη Πρόσληψη Οξυγόνου (VO2max) μεταξύ 
πρώτης, δεύτερης και τρίτης μέτρησης (F2,10 = 3.295, p = . 080). 



Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

 
Descriptive Statistics 

 

 Mean Std. Dev iation N 

stats_1 7,17 1,169 6 

stats_2 8,00 1,265 6 

stats_3 8,67 1,033 6 

 
 

 
 

 
Measure: MEASURE_1 

Mauchly's Test of Sphericityb 

 
 

 
Within Subjects Eff ect 

 
 

 
Mauchly 's W 

 

 

Approx. 

Chi-Square 

 
 

 
df 

  

Epsilon
a

 

Greenhous 

e-Geisser 
 
Huynh-Feldt 

 
Lower-bound Sig. 

STATS ,747 1,165 2 ,559 ,798 1,000 ,500 

Tests the null hypothesis that the error covariance matrix of the orthonormalized transf ormed dependent variables is 

proportional to an identity matrix. 

a. May be used to adjust the degrees of f reedom f or the averaged tests of significance. Corrected tests are display ed in 

the Tests of Within-Subjects Eff ects table. 

b. 

Design: Intercept 

Within Subjects Design: STATS 



Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

 

 
Tests of Within-Subjects Effects 

Measure: MEASURE_1 

 Ty pe III Sum 

of Squares 

  
Mean Square 

  

Source df F Sig. 

STATS Sphericity Assumed 6,778 2 3,389 17,941 ,000 

Greenhouse-Geisser 6,778 1,597 4,245 17,941 ,002 

Huy nh-Feldt 6,778 2,000 3,389 17,941 ,000 

Lower-bound 6,778 1,000 6,778 17,941 ,008 

Error(STATS) Sphericity Assumed 1,889  10 ,189   

Greenhouse-Geisser 1,889 ,237 7,983 

Huy nh-Feldt 1,889 10,000 ,189 

Lower-bound 1,889 5,000 ,378 



Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

 

 
Pairwise Comparisons 

Measure: MEASURE_1 

 
 

 
(I) STATS 

 
 

 
(J) STATS 

 
Mean 

Dif f erence 

(I-J) 

 
 

 
St d. Error 

  

95% Conf idence Interv al f or 

Dif f erencea 

 Sig.a Lower Bound Upper Bound 

1 2 -,833* ,307  ,042 -1,623 -,043 

 3 -1,500* ,224 ,001 -2,075 -,925 

2 1 ,833* ,307  ,042 ,043 1,623 

 3 -,667* ,211 ,025 -1,209 -,125 

3 1 1,500* ,224  ,001 ,925 2,075 

 2 ,667* ,211 ,025 ,125 1,209 

Based on estimated marginal means 

*. The mean dif f erence is signif icant at the , 05 lev el. 

a. Adjustment f or multiple comparisons: Least Signif icant Dif f erence (equiv alent to no 

adjustments). 

 



Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο Παράγοντα 
(One-way repeated measures ANOVA) 

 
Εφαρμόστηκε Ανάλυση Διακύμανσης με Ένα Επαναλαμβανόμενο 
Παράγοντα (One-way repeated measures ANOVA) για να εξεταστεί 
εάν υπάρχουν στατιστικά σημαντικές διαφορές στη βαθμολογία της 
Στατιστικής μεταξύ πρώτου (stats_1), δευτέρου (stats_2) και τρίτου 
τεστ αξιολόγησης (stats_3). Από τα αποτελέσματα φαίνεται ότι 
υπάρχουν στατιστικά σημαντικές διαφορές στη Στατιστική μεταξύ 
πρώτου (stats_1), δευτέρου (stats_2) και τρίτου τεστ (F2,10 = 17.941, p 
< . 001). Στη συνέχεια, εφαρμόστηκε το τεστ Πολλαπλών Συγκρίσεων 
LSD για να εξεταστεί μεταξύ ποιών βαθμίδων του επαναλαμ- 
βανόμενου παράγοντα «τεστ αξιολόγησης» (stats) υπάρχουν οι 
στατιστικά σημαντικές διαφορές. Aπό τα αποτελέσματα φαίνεται ότι 
οι μαθητές/ τριες είχαν υψηλότερο σκορ στη Στατιστική στο τρίτο τεστ 
αξιολόγησης (M = 8.67 ± 1.03) σε σχέση με το πρώτο τεστ (M = 7.17 ± 

1.17) και το δεύτερο τεστ (M = 8 ± 1.27). 
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